MAXREFDES117#: HEART-RATE AND PULSE-OXIMETRY
MONITOR

The MAXREFDES117# reference design is a low power, optical heart-rate module complete
with integrated red and IR LEDs, and a power supply. This tiny board, perfect for wearable
projects, may be placed on a finger or earlobe to accurately detect heart rate. This versatile
module works with both Arduino and mbed platforms for quick testing, development and
system integration. A basic, open-source heart-rate and SpO, algorithm is included in the
example firmware.

The board features 8 sewing tap pads for attachment and quick electrical connection to a
development platform.

As with all Maxim reference designs, the BOM, schematics, layout files, and Gerber files are
all available from the Design Resources tab. In addition, boards are available for purchase.

Features

e Optical Heart-Rate Monitor and Pulse Oximetry Solution

e Tiny 12.7mm x 12.7mm (0.5in x 0.5in) Board Size

e Low Power

e Device Drivers

e Free Algorithm

o Example C Source Code For Arduino And mbed Platforms
o Test Data

Competitive Advantages

o Highly-integrated, small-size sensor
e Non-chest based heart-rate/SpO, detection
e Ultra-low power consumption

Applications

o Wearables
e Heart-rate monitor
e Pulse oximeter


https://www.maximintegrated.com/en/design/reference-design-center/system-board/6300.html/tb_tab2

MAXREFDES117# System Board

Introduction

Wearable devices hold the potential to transform health and medical monitoring. Heart rate,
specifically, provides tremendous insight into heart function and health, during both activity
and rest. Innovation and development of both optical semiconductors and lower-power
integrated circuits makes the transition to wearables possible. Until now, only large

organizations, with deep development budgets, could deliver such advanced products.

MAXREFDES117# delivers the promise of wearable devices to all developers. This unique
design measures both heart rate and pulse oximetry. MAXREFDES117# features the
MAX30102 with integrated red and IR LEDs for heart-rate and SpO, detection. This
configuration ideally detects heart rate and pulse ox on a person’s fingertip, earlobe, or other
fleshy extremity. The small board size of 12.7mm x 12.7mm (0.5in x 0.5in) is ideal for
wearable applications and may be stitched into fabric for immediate prototyping. Firmware is
available for both Arduino and mbed platforms, enabling users to develop with virtually any
platform. User needs to provide a 2V to 5.5V supply at the power input, perfect for virtually

any battery or Arduino and mbed form-factor board.

The MAXREFDES117# design utilizes the heart-rate/SpO, sensor (MAX30102), an efficient,
low-power step-down converter (MAX1921), and an accurate level translator (MAX14595).
The entire design typically operates at less than 5.5mW when using with the example

firmware. A block diagram of the system is shown in Figure 1.
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System Diagram
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Figure 1. MAXREFDES98# reference design block diagram.

The power requirement is shown in Table 1.

Table 1. Power Requirement for the MAXREFDES117# Reference
Design

Input Voltage (V) Input Current
(mA, typ)

2V to 5.5V 1.5mA (3.3V input)

Note: Controller board is powered separately

The MAXREFDES117# reference design is a PPG-based heart-rate and SpO2 monitor
subsystem. The circuit utilizes the MAX30102 heart-rate/SpO2 sensor with integrated red
and IR LEDs. The step-down converter MAX1921 converts the 2V to 5.5V supply input and
generates the 1.8V rail for the heart-rate sensor. The MAX14595 level translator provides an
interface between the heart-rate/SpO2 sensor and the controller board, which generally use

a different logic level.



Detailed Description of Firmware

The MAXREFDES117# can be used with virtually any microcontroller that has I1°C interface.
The Arduino and mbed example firmware have been tested on the following development
platforms:
mbed:

e Maxim Integrated MAX32600MBED#

e Freescale FRDM-K64F

e Freescale FRDM-KL25Z

Arduino:
e Adafruit Flora
e Lilypad USB

e Arduino UNO

Users may read sampled data, calculated heart rate and SpO, through a terminal program,
allowing analysis on excel or any third-party software. The simple process flow is shown

in Figure 2.
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Figure 2. The MAXREFDES117# firmware flowchart.



The complete source code, including the heart rateheart-rate/SpO,algorithm, is provided to
accelerate development. Code documentation can be found in the corresponding firmware

platform files.

Heart rateHeart-rate accuracy varies depending on the chosen platform. The tested mbed
platforms give more accurate heart-rate/SpO, calculations than the tested Arduino platforms
because the mbed platform controllers have more SRAM than the Arduino platform
controllers. For the example firmware, mbed platforms store 5 seconds of samples collected

at 100sps, while the Arduino platforms store 4 seconds of samples collected at 25sps.

SpO, calculation is based on the equation shown below. However, determining the
constants (C;, C,, and C3) requires a comprehensive clinical study of pulse pulse-oximetry
data from a statistically significant population set using this hardware. Such a clinical study is
beyond scope of this design. Therefore, the calculated SpO, value may havecan have an

error.
SpO, =C; % AverageRatio2 + C, x AverageRation + C;

Where AverageRatio is the average ratio of IR and red LED readings. C,, C,, and C; are

constants.

Quick Start

Required equipment:

e Windows PC with a USB port

e MAXREFDES117# board

e 5 cables that can be used to connect the MAXREFDES117# with the controller board
e One of the supported mbed or Arduino controller boards listed above

e One USB cable that is compatible with the selected controller board

Download, read, and carefully follow each step in the appropriate MAXREFES117# quick
Start Guide:

* MAXREFDES117# mbed Quick Start Guide

* MAXREFDES117# Arduino Quick Start Guide
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Lab Measurements

Equipment used:
e MAX32600MBED#
e Adafruit Flora
e Adafruit BlueFruit
e Polar H7 Bluetooth Smart Heart RateHeart-Rate Sensor

e Android tablet

Figure 3 and Figure 4 show how the MAXREFDES117 calculated heart rate compared to
the Polar H7 chest strap. The data in Figure 3 were taken while the person was sitting still
for 20 minutes. And the data in Figure 4 were taken while the person was walking at a

normal speed for 20 minutes.
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Figure 3. For sedentary test, over 99% of the mbed + MAXREFDES117# heart heart-rate

data are less than 5 beats/min delta from the Polar H7 chest strap.
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Figure 4. For moving test, over 92% of the Arduino + MAXREFDES117# heart- rate data are

less than 10 beats/min delta from the Polar H7 chest strap.

Quick Start

Required equipment:

e Windows PC with a USB port

e MAXREFDES117# board

e 5 cables that can be used to connect the MAXREFDES117# with the controller board
e One of the supported mbed or Arduino controller boards listed above

e One USB cable that is compatible with the selected controller board

Download, read, and carefully follow each step in the appropriate MAXREFDES117# quick
Start Guide:

* MAXREFDES117# mbed Quick Start Guide

Quick Start: Required equipment:

e Windows PC with a USB port

e MAXREFDES117# board

e 5 pieces of wires to connect the MAXREFDES117# to the controller board

e One of the three supported controller boards (Maxim Integrated MAX32600MBED#,
Freescale FRDM-KL25Z, or Freescale FRDM-K64F)

e One micro USB cable (for MAX32600MBED# and FRDM-K64F)

e One mini USB cable (for FRDM-KL25Z) Procedure
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The reference design is fully assembled and tested. Follow the steps below to verify board

operation:

1. Create an account on http://developer.mbed.org to use their online compiler.

2. Import the demo program from https://developer.mbed.org/teams/Maxim-
Integrated/code/RD117_MBED/
3. Connect the MAXREFDES117 to the controller board: For MAX32600MBED#

MAX32600MBED# port MAXREFDES117 port

P26 SDL SDA
P27 SCL SCL
P20 SCK RX INT
3.3V VIN
GND GND

4. For FRDM-K64F

FRDM-K64F port MAXREFDES117 port

E25 SDA
E24 SCL
D1 INT
P3V3 VIN

GND GND


http://developer.mbed.org/

5. For FRDM-KL25Z

FRDM-KL25Z port MAXREFDES117 port

EO SDA
El SCL
D1 INT
3.3V VIN
GND GND

6. Connect the controller board to the PC with a USB cable.

7. In the MBED compiler, click the button at the upper right hand corner to select the
appropriate controller board.

8. Compile and download the resulting binary to your mbed platform.
Press the Upload menu item in the Sketch menu to upload the firmware to the Flora
board.

10. Open Hyperterminal or a similar terminal program on the PC. Find the appropriate
COM port and configure the connection for 115200, 8-N-1 with no flow control.

11. Put a finger on top of the U1 on the MAXREFDES117#, contact with an earlobe is
also sufficient. Constant pressure yields the best result.

12. Press any key on the terminal program and the system will start the conversion.

13. From left to right, the first two column shows the data for red and IR LED receiver.
Third and fifth columns show the calculated heart rate and SpO2 values. And the

fourth and sixth columns show the validities of the heart rate and SpO2 calculations.

¥ MAXREFDES117# Arduino Quick Start Guide
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Quick Start

Required equipment:

Windows PC with a USB port

MAXREFDES117# board

5 cables with grabber clips on both ends.

One of the three supported controller boards (Adafruit Flora, Lilypad USB, or Arduino
UNO board)

One micro USB cable (for Lilipad or Flora)

One A to B USB cable (for Arduino UNO) Procedure

The reference design is fully assembled and tested. Follow the steps below to verify board

operation:

1.

If Arduino IDE is not installed on the PC follow the getting started guide to install the
Arduino IDE on the PC.

If Adafruit Flora board is selected as the controller board:

o Follow the Adafruit Windows Driver installation guide to install the driver.

o Follow the "Adafruit Arduino IDE setup guide" to install the Arduino IDE and
support files for Adafruit Flora board.
Download the source code RD117_ARDUINO.zip file and unzip it in a desired
location.
Double click the RD117_ARDUINO.ino to open the project in Arduino IDE.
Connect the MAXREFDES117 to the controller board: For Flora

Flora port MAXREFDES117 port

SDA SDA
SCL SCL
D10 INT
3.3V VIN

GND GND


http://www.arduino.cc/en/Guide/Windows
https://learn.adafruit.com/getting-started-with-flora/windows-setup

6. For Lilypad USB

Lilypad USB port MAXREFDES117 port

2 SDA
3 scL
10 INT
+ VIN
) GND

7. For Arduino UNO

Arduino UNO port MAXREFDES117 port

SDA SDA
SCL SCL
10 INT
3.3V VIN
GND GND

8. Connect the controller board to the PC with a USB cable.
In the Arduino IDE, click on the Tools menu and make sure the appropriate board is
selected.

10. Select the proper communication port in the Tools menu.

11. Press the Upload menu item in the Sketch menu to upload the firmware to the Flora

board.



12. Open Hyperterminal or a similar terminal program on the PC. Find the appropriate
COM port and configure the connection for 115200, 8-N-1 with no flow control.
13. Put a finger on top of the U1 on the MAXREFDES117#, contact with an earlobe is

also sufficient. Constant pressure yields the best result.

14. Press any key on the terminal program and the system will start the conversion.

ALUTUOWE Ty ArTAnvwaEwy HMTULLO Ly JLVETJIUy WAiwLTdLod—io
red=65632, ic=120084, HRvalid=1, SP02=38, SPOIValid=1
red=654EE, 1lr=119504, HRvalid=1, 3P02=98, SPO2Valid=l
red=6522E, 1r=11E49E, HRvalid=l, SPOZ=33, SPOZValid=l
red=65082, 1r=117901, BRvalidel, SPOZ=88, SPOZValid=l
red=65061, ic=11769%, HRvalid=l, 5PO2=32, SPOiValid=l
zed=65025, 1r=117713, HRvalid=1,6 SPOQ2=08, SPO2Valid=l
red=65076, 1r=11T7778, HRvalidel, SPOZ=33, JPOZValid=l
red=65116, 1c=117917, HBRvalidel, 5POZ=538, SPOZValidel
red=65153, ir=118100, HRvalid=1l, SPO2=38, SPOZValid=l
Ted=65178, ic=11E13E, HRvalid=l, 5PQ2=38, 3FP02WValid=1
red=65181, ir=11E195, HRvalidg=1, 3POZ=98, SPOZValid=l
red=65181, 1e=11B244, BRwvalidel, 5POZ=38, SPOZValidel
red=651%4, 1c=11834%9, HRvalid=1, 5PO2=%8, SPCZValid=l
red=65241, ir=118507, HRvalid=1, SPO2=38, 3P0ZValid=1
Ted=83255,; 1lc=118T1Z, HRvalidel, SFOZ=33; IFOZValid=l
red=65354, ir=118921, BRwvalidel, 5PO2=38, SPOZValidwel
red=65404, ir=119102, HRvalids=l, SPO2=898, SPOZValid=1

[#] Autasaral

15. From left to right, the first two column shows the data for red and IR LED receiver.
Third and fifth columns show the calculated heart rate and SpO2 values. And the
fourth and sixth columns show the validities of the heart rate and SpO2 calculations.

All Design Files

Download All Design Files

Hardware Files:
Schematic

Bill of Materials (BOM)
PCB Layout

PCB Fab Package
PCB CAD (PADS 9.0)

Firmware Files:

Arduino Platform

mbed Platform


http://www.maximintegrated.com/design/tools/appnotes/6300/RD117V01_00.zip
http://www.maximintegrated.com/design/tools/appnotes/6300/MAXREFDES117_SCH_RA.pdf
http://www.maximintegrated.com/design/tools/appnotes/6300/MAXREFDES117_BOM_RA.pdf
http://www.maximintegrated.com/design/tools/appnotes/6300/MAXREFDES117_LAYOUT_RA.pdf
http://www.maximintegrated.com/design/tools/appnotes/6300/MAXREFDES117_FAB_PACKAGE_RA.zip
http://www.maximintegrated.com/design/tools/appnotes/6300/MAXREFDES117_CAD_RA.zip
http://www.maximintegrated.com/design/tools/appnotes/6300/RD117_ARDUINO_V01_00.zip
http://www.maximintegrated.com/design/tools/appnotes/6300/RD117_MBED_V01_00.zip
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